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Outlook 2000

Users can configure the Outlook 2000 email program to retrieve email from any standards-based IMAP 
or POP mail server through the Neoteris IVE. If your corporate mail server is an Exchange Server, 
however, and your users are laptop users who use the same machine while in-house and traveling, 
users need to configure one of the following clients to retrieve email while working remotely:

• Outlook Express 5.5 or 6.x (in IMAP or POP mode)
• Netscape Messenger 4.7x (in IMAP mode only)
• Netscape Mail 6.2 (in IMAP mode only)

The reason:

If your corporate mail server is an Exchange Server, the Outlook 2000 client running on laptops will 
probably be configured with a MAPI email account (using Microsoft’s proprietary MAPI protocol) for in-
house use. Because the Outlook 2000 client only allows one mail server configuration, users need to 
configure an additional client to retrieve emails when out of the office. Users may configure the Outlook 
2000 client on a separate home PC to retrieve email from the corporate Exchange Server via the 
Neoteris IVE as long as no other Outlook 2000 email account is configured on that machine.

Note: If your site uses an Exchange Server (versus an IMAP or POP server), users do not need to change
their email set up in order to use the IVE to access email from a remote location. 
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Configuring an Email Client
The Secure Email Client upgrade option enables Neoteris IVE users to use standards-
based email clients to access corporate email from remote locations. This document 
provides information to help administrators determine which supported email client 
to recommend to users, as well as procedural information (written for users) for 
configuring each of the supported email clients. The supported email clients include 
Outlook 2000, Outlook 2002, Outlook Express 5.5 and 6.x, Netscape Messenger 4.7, 
and Netscape Mail 6.2.
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To configure the Outlook 2000 email program for an IMAP or POP mail 
server:

1. From the Outlook 2000 Tools menu, choose Accounts. The Internet Accounts dialog appears.

 Figure 1:  Internet Accounts Dialog

2. Select the Mail tab and then click Add > Mail. The Internet Connection Wizard appears.

 Figure 2:  Internet Connection Wizard - Your Name Page

3. On the Your Name page, enter the name you want to display for messages sent from your account 
and click Next.

4. On the Internet E-mail Address page, enter your corporate email address and click Next.
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5. On the E-mail Server Names page, specify the type of mail server used for corporate email: POP or 
IMAP. Next, enter the name of the IVE server for both the incoming and outgoing mail servers and 
then click Next. For example, if the URL to your IVE is https://iveserver.yourcompany.com, then 
the mail server address to enter is iveserver.yourcompany.com. If you entered email settings through 
the IVE Email Setup page, enter the mail server name that displayed after you completed the setup. 

 Figure 3:  Internet Connection Wizard - E-mail Server Names Page

6. On the Internet Mail Logon page, enter your user name for the mail server. If you do not enter the 
same password each time for email, make sure to clear the Remember password box. When you 
are finished, click Next. For example, if you entered email settings through the secure gateway 
Email Setup page, enter the username that displayed after you completed the setup.
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7. On the connection page, specify the method you want to use to connect to the Internet and then click 
Next.   

 Figure 4:  Internet Connection Wizard - Connection Options Page

8. On the Congratulations page, click Finish. The new email account appears in the Internet 
Accounts dialog.

 Figure 5:  New Account in Internet Accounts Dialog

9. Select the new email account and click Properties. The Properties dialog appears.

10. In the Properties dialog, select the General tab. Enter a name for this account, such as Corporate 
Email Account. This name appears in the Properties dialog title bar.
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11. In the Properties dialog, select the Servers tab. Under Outgoing Mail Server, check My server 
requires authentication and then click Settings. The Outgoing Mail Server dialog appears. 

 Figure 6:  Properties Dialog - Servers Tab

12. In the Outgoing Mail Server dialog, select Use same settings as my incoming mail server and 
then click OK, which returns you to the Properties dialog.

13. In the Properties dialog, select the Advanced tab. Under Server Port Numbers, check This 
server requires a secure connection (SSL) for both the outgoing and incoming mail server.

The incoming mail port number will automatically change to 993 for IMAP or 995 for POP, but you need 
to manually change the outgoing mail server port to 465. When you are finished, click OK to save your 
settings and return to the Internet Accounts dialog. 

 Figure 7:  Properties Dialog - Advanced Tab
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14. In the Internet Accounts dialog, click Close. If you are prompted to download folders from the mail 
server you just added, click Yes to display the Show/Hide IMAP Folders dialog. Select the All tab, 
click Reset List, and then click OK to download folders. When prompted for your password, enter the 
password required by your system administrator.

Note:You may receive a warning that the server you are connected to is using a certificate that could not be
verified. Simply click Yes to proceed.

15. Expand the new account and click on the Inbox. Messages from the mail server appear in the Inbox.

Important:Until the system administrator obtains a signed digital certificate for the IVE server, you may
be prompted with one or more security or IP address warnings each time they open the Inbox. The IVE
server is fully functional and secure, however, and you may choose to proceed.

Outlook 2002

Users can configure the Outlook 2002 email program to retrieve email from any standards-based IMAP 
or POP mail server through the Neoteris IVE. If your corporate mail server is an Exchange Server, 
however, and your users are laptop users who uses the same machine while in-house and traveling, 
users need to configure one of the following clients to retrieve email while working remotely:

• Outlook Express 5.5 or 6.x (in IMAP or POP mode)
• Netscape Messenger 4.7x (in IMAP mode only)
• Netscape Mail 6.2 (in IMAP mode only)

The reason:

If your corporate mail server is an Exchange Server, the Outlook 2002 client running on user laptops 
will probably be configured with a MAPI email account (using Microsoft’s proprietary MAPI protocol) for 
use while in-house. Even though the Outlook 2002 client provides support for simultaneous server 
configurations, it does not support IMAP access when the MAPI account is offline, preventing users from 
retrieving emails when working remotely. Users may configure the Outlook 2002 client on a separate 
home PC to retrieve email from the corporate Exchange Server via the Neoteris IVE.

Note: If your site uses an Exchange Server (versus an IMAP or POP server), users do not need to change
their email set up in order to use the IVE to access email from a remote location. 
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To configure the Outlook 2002 email program for an IMAP or POP server:

1. From the Outlook Tools menu, choose E-mail Accounts. The E-mail Accounts wizard appears.

 Figure 8:  E-mail Accounts Wizard

2. On the E-mail Accounts page, select Add a new e-mail account and click Next.

3. On the Server Type page, specify the type of mail server used for your corporate email—POP or 
IMAP—and click Next.

4. On the Internet E-mail Settings page, enter the requested user, server, and logon information:

• Your Name: The display name to use for messages sent from your account.
• E-mail Address: Your corporate email address.
• Incoming mail server: The IVE server name*.
• Outgoing mail server: The IVE server name*.
• User Name: The name* you use to log in to your mail server.
• Password: Leave this field blank. If you do not enter the same password each time for email, 

make sure to clear the Remember password box.

*If you entered email settings through the IVE Email Setup page, enter the mail server name and user 
name that displayed after you completed the setup. If you did not enter email settings through the IVE 
Email Setup page and the URL to your IVE is https://IVEserver.yourcompany.com, then the 
address to enter as the incoming and outgoing mail server is IVEserver.yourcompany.com.
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 Figure 9:  Internet E-Mail Settings Page (IMAP configuration shown)

5. On the Internet E-mail Settings page, click More Settings. The Internet E-mail Settings dialog 
appears.

 Figure 10:  Internet E-mail Settings Dialog - General Tab

6. In the Internet E-mail Settings dialog, select the General tab and enter a name for this account, 
such as Corporate Email Account.
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7. In the Internet E-mail Settings dialog, select the Outgoing Server tab and check My outgoing 
server (SMTP) requires authentication. (Keep the option Use same settings as my incoming 
mail server.)

 Figure 11:  Internet E-mail Settings Dialog - Outgoing Server

8. In the Internet E-mail Settings dialog, select the Advanced tab to configure server settings:

Under Server Port Numbers, check This server requires a secure connection (SSL) for both the 
incoming and outgoing mail server.
The incoming mail port number will automatically change to 993 for IMAP or 995 for POP, but you need 
to manually change the outgoing mail server port to 465. When you are finished, click OK to save your 
settings and return to the Outlook window.

 Figure 12:  Internet E-mail Settings - Advanced Tab
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9. Expand the new account and click on the Inbox. If you are prompted for your password, enter the 
password required by your system administrator. Messages from the mail server appear in the Inbox. 

Important:If the system administrator has not obtained a signed digital certificate for the IVE server, you
may be prompted with one or more security or IP address warnings each time you open the Inbox. The
IVE server is fully functional and secure, however, and you may choose to proceed.

Outlook Express 5.5 and 6.x

If your corporate mail server is a Microsoft Exchange Server and users use the Outlook 2000 or 2002 
email program when in the office, note that deleted emails appear in the Outlook Express Inbox with a 
strike through them; they are not moved to the Deleted Items folder on the Exchange Server, which is 
the behavior when using the Outlook 2000 or 2002 program. When users purge deleted emails in an 
Outlook Express program, the emails are gone forever. If users do not purge them, then the emails 
appear in the Outlook 2000 or 2002 program the next time they use it.

To ensure that users do not permanently delete emails they may need to retrieve later, we 
recommend that when working within Outlook Express 5.5 or 6.x, users either:

• Manually drag emails they wish to delete to the Deleted Items folder that appears under Local Folders 
(these are default folders that appear). This folder syncs with the Deleted Items folder on the Exchange 
Server, enabling users to retrieve deleted emails later.

• Leave deleted emails in the Outlook Express Inbox, and then the next time they log in to Outlook 2000 or 
2002 program, move the deleted emails to the Deleted Items folder.

To configure the Outlook Express 5.5 or 6.x email program:

1. From the Outlook Express Tools menu, choose Accounts. The Internet Accounts dialog appears.

 Figure 13:  Internet Accounts Dialog
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2. Select the Mail tab and then click Add > Mail. The Internet Connection Wizard appears.

 Figure 14:  Internet Connection Wizard - Your Name Page

3. On the Your Name page, enter the display name to use for messages sent from your account and 
click Next.

4. On the Internet E-Mail Address page, enter your corporate email address and click Next.

5. On the Email Servers page, specify the type of mail server used for your corporate email: POP or 
IMAP. Next, enter the name of the IVE server for both the incoming and outgoing mail servers. When 
you are finished, click Next. For example, if the URL to your IVE is 
https://IVEserver.yourcompany.com, then the mail server address to enter is 
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IVEserver.yourcompany.com. If you entered email settings through the IVE Email Setup page, 
enter the mail server name that displayed after you completed the setup.

 Figure 15:  Internet Connection Wizard - E-mail Servers Page

6. On the Internet Mail Logon page, enter the user name for the mail server. If you do not enter the 
same password each time for email, make sure to clear the Remember password box. When you 
are finished, click Next. The Congratulations page appears.

If you entered email settings through the IVE Email Setup page, enter the user name that displayed 
after you completed the setup.

7. On the Congratulations page, click Finish. The new email account appears in the Internet 
Accounts dialog.

 Figure 16:  New Account in Internet Accounts Dialog
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8. Select the new email account and click Properties. The Properties dialog appears.

9. In the Properties dialog, select the General tab. Enter a name for this account, such as Corporate 
Email Account. This name appears in the Properties dialog title bar.

10. In the Properties dialog, select the Servers tab. Under Outgoing Mail Server, check My server 
requires authentication and then click Settings. The Outgoing Mail Server dialog appears. 

 Figure 17:  Properties Dialog - Servers Tab

11. In the Outgoing Mail Server dialog, select Use same settings as my incoming mail server and 
then click OK.

12. In the Properties dialog, select the Advanced tab. Under Server Port Numbers, check This 
server requires a secure connection (SSL) for both the outgoing and incoming mail server.

The incoming mail port number will automatically change to 993 for IMAP or 995 for POP, but you need 
to manually change the outgoing mail server port to 465. When you are finished, click OK to save your 
settings and return to the Internet Accounts dialog. 

 Figure 18:  Internet Accounts Dialog - Advanced Tab
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13. In the Internet Accounts dialog, click Close. If you are prompted to download folders from the mail 
server you just added, click Yes to display the Show/Hide IMAP Folders dialog. Select the All tab, 
click Reset List, and then click OK to download folders. When prompted for your password, enter the 
password required by your system administrator.

Note:You may receive a warning that the server you are connected to is using a certificate that could not be
verified. Simply click Yes to proceed.

14. Expand the new account and click on the Inbox. Messages from the mail server appear in the Inbox.

Note:When using Outlook Express 6.x, if you are prompted to log in more than one time, go to Tools >
Options and on the General tab, uncheck When starting, go directly to my 'Inbox' folder. 

15. If your corporate mail server is an Exchange Server and you use either the Outlook 2000 or 2002 
program when working in the office:

From the Outlook Express View menu, select Current View and make sure that Show All Messages 
is selected. This option ensures that your Outlook Express and Outlook 2000/2002 program Inboxes 
appear synchronized.

Important:Until the system administrator obtains a signed digital certificate for the IVE server, you may
be prompted with one or more security or IP address warnings each time you open the Inbox. The IVE
server is fully functional and secure, however, and you may choose to proceed.

Netscape Messenger 4.7x

To retrieve email form a remote location using Netscape Messenger on a laptop or home machine, users 
must configure Netscape Messenger in IMAP mode because it does not support Secure-POP, which is 
required by the Neoteris IVE. If your corporate mail server is a Microsoft Exchange Server and users 
use the Outlook 2000 or 2002 email program when in the office, note that when using the Netscape 
program, deleted emails are moved to the Netscape Trash folder and no longer appear in the Netscape 
Inbox, but they do not disappear from the Outlook 2000 or 2002 Inbox unless users do two things:

1 Configure the Netscape program to move deleted messages to the Trash folder and check the 
option to expunge the Inbox upon exiting (using the Mail Server Properties dialog).

2 Run only one program at a time and exit when finished so that the other program’s Inbox synchro-
nizes with the server and displays the same messages.

To configure the Netscape Messenger 4.7x email program:

1. From the Netscape Messenger Edit menu, choose Preferences. The Preferences dialog appears.
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2. In the Preferences dialog, expand Mail & Newsgroups and then choose Mail Servers.

 Figure 19:  Preferences Dialog

3. In the Mail Servers section, delete any mail servers listed under Incoming Mail Servers and then 
click Add. The Mail Server Properties dialog appears.

4. In the Mail Server Properties dialog, select the General tab to configure the mail server:

Enter the name of the IVE server, specify IMAP as the type of mail server, and enter the name you use 
to log in to your corporate mail server. If you do not enter the same password each time for email, 
make sure to clear the Remember password box. For example, if you entered email settings through 
the IVE Email Setup page, enter the mail server name and user name that displayed after you 
completed the setup. If you did not enter email settings through the IVE Email Setup page and the 
URL to your IVE is https://IVEserver.yourcompany.com, then the address to enter as the incoming 
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and outgoing mail server is IVEserver.yourcompany.com. 

 Figure 20:  Mail Server Properties Dialog - General Tab

5. In the Mail Server Properties dialog, select the IMAP tab to configure connection and deletion 
settings:

Select Use secure connection (SSL), Move it to the trash folder and Clean up (“Expunge”) 
Inbox on exit. When you are finished, click OK to return to the Mail Servers section of the 
Preferences dialog. 

6. Under Outgoing Mail Server:

• Make sure the Outgoing mail (SMTP) server is the server you entered in In the Mail Server 
Properties dialog, select the General tab to configure the mail server:. If not, enter the server 
name now.

• In the Outgoing mail server user name field, enter the name you use to log in to your 
corporate mail server.

• Under Use Secure Socket Layer (SSL) or TSL for outgoing messages, select Always. The 
new account appears in your list of email accounts.

7. When you are finished, click OK. 
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To begin using your new email account, expand the account name so that you see the Inbox and its 
messages. You may need to click the Get Msg button in the Netscape Messenger toolbar. When 
prompted for your password, enter the password required by your system administrator.

Important:If your system administrator has not obtained a signed digital certificate for the IVE server, you
may be prompted with one or more security or IP address warnings each time you open the Inbox. The
IVE server is fully functional and secure, however, and you may choose to proceed.

Netscape Mail 6.2

To retrieve email form a remote location using Netscape Mail on a laptop or home machine, users must 
configure Netscape Mail in IMAP mode because it does not support Secure-POP, which is required by the 
Neoteris IVE. If your corporate mail server is a Microsoft Exchange Server and users use the Outlook 
2000 or 2002 email program when in the office, note that when using the Netscape program, deleted 
emails are moved to the Netscape Trash folder and no longer appear in the Netscape Inbox, but they do 
not disappear from the Outlook 2000 or 2002 Inbox unless users do two things:

1 Configure the Netscape program to move deleted messages to the Trash folder and check the 
option to expunge the Inbox upon exiting (using the Server Settings dialog).

2 Run only one program at a time and exit when finished so that the other program’s Inbox synchro-
nizes with the server and displays the same messages.
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To configure the Netscape Mail 6.2 email program:

1. From the Netscape 6 browser Tasks menu, choose Mail & Newsgroups. The Local Folders page 
appears.

 Figure 21:  Local Folders Page in Netscape 6

2. On the Local Folders page, click Create a new account to launch the Account Wizard.

3. On the New Account Setup page, make sure ISP or email provider is selected and click Next.
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4. On the Identity page, enter the name to be displayed for messages sent from your account and your 
corporate email address. When you are finished, click Next.

 Figure 22:  Account Wizard - Identity Page

5. On the Server Information page, specify IMAP as the type of mail server, enter the name of the IVE 
server¹ for both the incoming and outgoing mail servers², and click Next.

¹If you entered email settings through the IVE Email Setup page, enter the mail server name that 
displayed after you completed the setup. If you did not enter email settings through the IVE Email 
Setup page and the URL to your IVE is https://IVEserver.yourcompany.com, then the address to 
enter as the incoming and outgoing mail server is IVEserver.yourcompany.com.
²If an IMAP server was previously defined for your email program, then you won't be prompted for an 
outgoing server name. In this case, you will need to set the IVE server as your default mail server in 
In the Outgoing Server (SMTP) Settings section, click Always under Use secure connection (SSL), and 



Configuring an Email Client

20 of 22

NESD-00090-00 CAY051402

Copyright © 2001-2003 Neoteris, Inc.

then click Advanced. The Advanced Outgoing Server (SMTP) Settings dialog appears.. 

 Figure 23:  Account Wizard - Server Information Page

6. On the User Name page, enter the name you use to log in to your corporate mail server. When you 
are finished, click Next. For example, if you entered email settings through the IVE Email Setup 
page, enter the user name that displayed after you completed the setup.

7. On the Account Name page, enter a name for your account and then click Next.

8. On the Congratulations page, click Finish to save your changes and exit the wizard. The new 
account appears on the Local Folders page.

9. From the Local Folders page Edit menu, choose Mail & Newsgroups Account Settings. The Mail 
& Newsgroups Account Settings dialog appears.
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10. In the Mail & Newsgroups Account Settings dialog, choose Server Settings under the account 
you just created.

 Figure 24:  Mail & Newsgroups Account Settings

11. In the Server Settings section:

• Check Use secure connection (SSL). Note that the port number automatically changes to 993.
• For When I delete a message, select Move it to the Trash folder.
• Check Clean up (“Expunge”) Inbox on Exit.

12. In the Mail & Newsgroups Account Settings dialog, select Outgoing Server (SMTP). The 
Outgoing Server (SMTP) Settings section appears.
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13. In the Outgoing Server (SMTP) Settings section, click Always under Use secure connection 
(SSL), and then click Advanced. The Advanced Outgoing Server (SMTP) Settings dialog 
appears.

 Figure 25:  Advanced Outgoing Server (SMTP) Settings Dialog

The IVE server name you entered on the Server Information page (On the Server Information page, 
specify IMAP as the type of mail server, enter the name of the IVE server¹ for both the incoming and 
outgoing mail servers², and click Next.) should appear as the default server. If it does not, select the 
IVE server name and click Set Default.

14. When you are finished, click OK to return to the Mail & Newsgroups Account Settings dialog, and 
then click OK again.

To begin using your new email account, expand the account name so that you see the Inbox and its 
messages. You may need to click the Get Msg button in the Netscape Messenger toolbar. When 
prompted for your password, enter the password required by your system administrator.

Important:If your system administrator has not obtained a signed digital certificate for the IVE server, you
may be prompted with one or more security or IP address warnings each time you open the Inbox. The
IVE server is fully functional and secure, however, and you may choose to proceed.
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Outlook 2000

Users can configure the Outlook 2000 email program to retrieve email from any standards-based IMAP 
or POP mail server through the Neoteris IVE. If your corporate mail server is an Exchange Server, 
however, and your users are laptop users who use the same machine while in-house and traveling, 
users need to configure one of the following clients to retrieve email while working remotely:

• Outlook Express 5.5 or 6.x (in IMAP or POP mode)
• Netscape Messenger 4.7x (in IMAP mode only)
• Netscape Mail 6.2 (in IMAP mode only)

The reason:

If your corporate mail server is an Exchange Server, the Outlook 2000 client running on laptops will 
probably be configured with a MAPI email account (using Microsoft’s proprietary MAPI protocol) for in-
house use. Because the Outlook 2000 client only allows one mail server configuration, users need to 
configure an additional client to retrieve emails when out of the office. Users may configure the Outlook 
2000 client on a separate home PC to retrieve email from the corporate Exchange Server via the 
Neoteris IVE as long as no other Outlook 2000 email account is configured on that machine.

Note: If your site uses an Exchange Server (versus an IMAP or POP server), users do not need to change
their email set up in order to use the IVE to access email from a remote location. 
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Configuring an Email Client
The Secure Email Client upgrade option enables Neoteris IVE users to use standards-
based email clients to access corporate email from remote locations. This document 
provides information to help administrators determine which supported email client 
to recommend to users, as well as procedural information (written for users) for 
configuring each of the supported email clients. The supported email clients include 
Outlook 2000, Outlook 2002, Outlook Express 5.5 and 6.x, Netscape Messenger 4.7, 
and Netscape Mail 6.2.
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To configure the Outlook 2000 email program for an IMAP or POP mail 
server:

1. From the Outlook 2000 Tools menu, choose Accounts. The Internet Accounts dialog appears.

 Figure 1:  Internet Accounts Dialog

2. Select the Mail tab and then click Add > Mail. The Internet Connection Wizard appears.

 Figure 2:  Internet Connection Wizard - Your Name Page

3. On the Your Name page, enter the name you want to display for messages sent from your account 
and click Next.

4. On the Internet E-mail Address page, enter your corporate email address and click Next.
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5. On the E-mail Server Names page, specify the type of mail server used for corporate email: POP or 
IMAP. Next, enter the name of the IVE server for both the incoming and outgoing mail servers and 
then click Next. For example, if the URL to your IVE is https://iveserver.yourcompany.com, then 
the mail server address to enter is iveserver.yourcompany.com. If you entered email settings through 
the IVE Email Setup page, enter the mail server name that displayed after you completed the setup. 

 Figure 3:  Internet Connection Wizard - E-mail Server Names Page

6. On the Internet Mail Logon page, enter your user name for the mail server. If you do not enter the 
same password each time for email, make sure to clear the Remember password box. When you 
are finished, click Next. For example, if you entered email settings through the secure gateway 
Email Setup page, enter the username that displayed after you completed the setup.
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7. On the connection page, specify the method you want to use to connect to the Internet and then click 
Next.   

 Figure 4:  Internet Connection Wizard - Connection Options Page

8. On the Congratulations page, click Finish. The new email account appears in the Internet 
Accounts dialog.

 Figure 5:  New Account in Internet Accounts Dialog

9. Select the new email account and click Properties. The Properties dialog appears.

10. In the Properties dialog, select the General tab. Enter a name for this account, such as Corporate 
Email Account. This name appears in the Properties dialog title bar.
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11. In the Properties dialog, select the Servers tab. Under Outgoing Mail Server, check My server 
requires authentication and then click Settings. The Outgoing Mail Server dialog appears. 

 Figure 6:  Properties Dialog - Servers Tab

12. In the Outgoing Mail Server dialog, select Use same settings as my incoming mail server and 
then click OK, which returns you to the Properties dialog.

13. In the Properties dialog, select the Advanced tab. Under Server Port Numbers, check This 
server requires a secure connection (SSL) for both the outgoing and incoming mail server.

The incoming mail port number will automatically change to 993 for IMAP or 995 for POP, but you need 
to manually change the outgoing mail server port to 465. When you are finished, click OK to save your 
settings and return to the Internet Accounts dialog. 

 Figure 7:  Properties Dialog - Advanced Tab
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14. In the Internet Accounts dialog, click Close. If you are prompted to download folders from the mail 
server you just added, click Yes to display the Show/Hide IMAP Folders dialog. Select the All tab, 
click Reset List, and then click OK to download folders. When prompted for your password, enter the 
password required by your system administrator.

Note:You may receive a warning that the server you are connected to is using a certificate that could not be
verified. Simply click Yes to proceed.

15. Expand the new account and click on the Inbox. Messages from the mail server appear in the Inbox.

Important:Until the system administrator obtains a signed digital certificate for the IVE server, you may
be prompted with one or more security or IP address warnings each time they open the Inbox. The IVE
server is fully functional and secure, however, and you may choose to proceed.

Outlook 2002

Users can configure the Outlook 2002 email program to retrieve email from any standards-based IMAP 
or POP mail server through the Neoteris IVE. If your corporate mail server is an Exchange Server, 
however, and your users are laptop users who uses the same machine while in-house and traveling, 
users need to configure one of the following clients to retrieve email while working remotely:

• Outlook Express 5.5 or 6.x (in IMAP or POP mode)
• Netscape Messenger 4.7x (in IMAP mode only)
• Netscape Mail 6.2 (in IMAP mode only)

The reason:

If your corporate mail server is an Exchange Server, the Outlook 2002 client running on user laptops 
will probably be configured with a MAPI email account (using Microsoft’s proprietary MAPI protocol) for 
use while in-house. Even though the Outlook 2002 client provides support for simultaneous server 
configurations, it does not support IMAP access when the MAPI account is offline, preventing users from 
retrieving emails when working remotely. Users may configure the Outlook 2002 client on a separate 
home PC to retrieve email from the corporate Exchange Server via the Neoteris IVE.

Note: If your site uses an Exchange Server (versus an IMAP or POP server), users do not need to change
their email set up in order to use the IVE to access email from a remote location. 
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To configure the Outlook 2002 email program for an IMAP or POP server:

1. From the Outlook Tools menu, choose E-mail Accounts. The E-mail Accounts wizard appears.

 Figure 8:  E-mail Accounts Wizard

2. On the E-mail Accounts page, select Add a new e-mail account and click Next.

3. On the Server Type page, specify the type of mail server used for your corporate email—POP or 
IMAP—and click Next.

4. On the Internet E-mail Settings page, enter the requested user, server, and logon information:

• Your Name: The display name to use for messages sent from your account.
• E-mail Address: Your corporate email address.
• Incoming mail server: The IVE server name*.
• Outgoing mail server: The IVE server name*.
• User Name: The name* you use to log in to your mail server.
• Password: Leave this field blank. If you do not enter the same password each time for email, 

make sure to clear the Remember password box.

*If you entered email settings through the IVE Email Setup page, enter the mail server name and user 
name that displayed after you completed the setup. If you did not enter email settings through the IVE 
Email Setup page and the URL to your IVE is https://IVEserver.yourcompany.com, then the 
address to enter as the incoming and outgoing mail server is IVEserver.yourcompany.com.
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 Figure 9:  Internet E-Mail Settings Page (IMAP configuration shown)

5. On the Internet E-mail Settings page, click More Settings. The Internet E-mail Settings dialog 
appears.

 Figure 10:  Internet E-mail Settings Dialog - General Tab

6. In the Internet E-mail Settings dialog, select the General tab and enter a name for this account, 
such as Corporate Email Account.
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7. In the Internet E-mail Settings dialog, select the Outgoing Server tab and check My outgoing 
server (SMTP) requires authentication. (Keep the option Use same settings as my incoming 
mail server.)

 Figure 11:  Internet E-mail Settings Dialog - Outgoing Server

8. In the Internet E-mail Settings dialog, select the Advanced tab to configure server settings:

Under Server Port Numbers, check This server requires a secure connection (SSL) for both the 
incoming and outgoing mail server.
The incoming mail port number will automatically change to 993 for IMAP or 995 for POP, but you need 
to manually change the outgoing mail server port to 465. When you are finished, click OK to save your 
settings and return to the Outlook window.

 Figure 12:  Internet E-mail Settings - Advanced Tab
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9. Expand the new account and click on the Inbox. If you are prompted for your password, enter the 
password required by your system administrator. Messages from the mail server appear in the Inbox. 

Important:If the system administrator has not obtained a signed digital certificate for the IVE server, you
may be prompted with one or more security or IP address warnings each time you open the Inbox. The
IVE server is fully functional and secure, however, and you may choose to proceed.

Outlook Express 5.5 and 6.x

If your corporate mail server is a Microsoft Exchange Server and users use the Outlook 2000 or 2002 
email program when in the office, note that deleted emails appear in the Outlook Express Inbox with a 
strike through them; they are not moved to the Deleted Items folder on the Exchange Server, which is 
the behavior when using the Outlook 2000 or 2002 program. When users purge deleted emails in an 
Outlook Express program, the emails are gone forever. If users do not purge them, then the emails 
appear in the Outlook 2000 or 2002 program the next time they use it.

To ensure that users do not permanently delete emails they may need to retrieve later, we 
recommend that when working within Outlook Express 5.5 or 6.x, users either:

• Manually drag emails they wish to delete to the Deleted Items folder that appears under Local Folders 
(these are default folders that appear). This folder syncs with the Deleted Items folder on the Exchange 
Server, enabling users to retrieve deleted emails later.

• Leave deleted emails in the Outlook Express Inbox, and then the next time they log in to Outlook 2000 or 
2002 program, move the deleted emails to the Deleted Items folder.

To configure the Outlook Express 5.5 or 6.x email program:

1. From the Outlook Express Tools menu, choose Accounts. The Internet Accounts dialog appears.

 Figure 13:  Internet Accounts Dialog
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2. Select the Mail tab and then click Add > Mail. The Internet Connection Wizard appears.

 Figure 14:  Internet Connection Wizard - Your Name Page

3. On the Your Name page, enter the display name to use for messages sent from your account and 
click Next.

4. On the Internet E-Mail Address page, enter your corporate email address and click Next.

5. On the Email Servers page, specify the type of mail server used for your corporate email: POP or 
IMAP. Next, enter the name of the IVE server for both the incoming and outgoing mail servers. When 
you are finished, click Next. For example, if the URL to your IVE is 
https://IVEserver.yourcompany.com, then the mail server address to enter is 
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IVEserver.yourcompany.com. If you entered email settings through the IVE Email Setup page, 
enter the mail server name that displayed after you completed the setup.

 Figure 15:  Internet Connection Wizard - E-mail Servers Page

6. On the Internet Mail Logon page, enter the user name for the mail server. If you do not enter the 
same password each time for email, make sure to clear the Remember password box. When you 
are finished, click Next. The Congratulations page appears.

If you entered email settings through the IVE Email Setup page, enter the user name that displayed 
after you completed the setup.

7. On the Congratulations page, click Finish. The new email account appears in the Internet 
Accounts dialog.

 Figure 16:  New Account in Internet Accounts Dialog
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8. Select the new email account and click Properties. The Properties dialog appears.

9. In the Properties dialog, select the General tab. Enter a name for this account, such as Corporate 
Email Account. This name appears in the Properties dialog title bar.

10. In the Properties dialog, select the Servers tab. Under Outgoing Mail Server, check My server 
requires authentication and then click Settings. The Outgoing Mail Server dialog appears. 

 Figure 17:  Properties Dialog - Servers Tab

11. In the Outgoing Mail Server dialog, select Use same settings as my incoming mail server and 
then click OK.

12. In the Properties dialog, select the Advanced tab. Under Server Port Numbers, check This 
server requires a secure connection (SSL) for both the outgoing and incoming mail server.

The incoming mail port number will automatically change to 993 for IMAP or 995 for POP, but you need 
to manually change the outgoing mail server port to 465. When you are finished, click OK to save your 
settings and return to the Internet Accounts dialog. 

 Figure 18:  Internet Accounts Dialog - Advanced Tab
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13. In the Internet Accounts dialog, click Close. If you are prompted to download folders from the mail 
server you just added, click Yes to display the Show/Hide IMAP Folders dialog. Select the All tab, 
click Reset List, and then click OK to download folders. When prompted for your password, enter the 
password required by your system administrator.

Note:You may receive a warning that the server you are connected to is using a certificate that could not be
verified. Simply click Yes to proceed.

14. Expand the new account and click on the Inbox. Messages from the mail server appear in the Inbox.

Note:When using Outlook Express 6.x, if you are prompted to log in more than one time, go to Tools >
Options and on the General tab, uncheck When starting, go directly to my 'Inbox' folder. 

15. If your corporate mail server is an Exchange Server and you use either the Outlook 2000 or 2002 
program when working in the office:

From the Outlook Express View menu, select Current View and make sure that Show All Messages 
is selected. This option ensures that your Outlook Express and Outlook 2000/2002 program Inboxes 
appear synchronized.

Important:Until the system administrator obtains a signed digital certificate for the IVE server, you may
be prompted with one or more security or IP address warnings each time you open the Inbox. The IVE
server is fully functional and secure, however, and you may choose to proceed.

Netscape Messenger 4.7x

To retrieve email form a remote location using Netscape Messenger on a laptop or home machine, users 
must configure Netscape Messenger in IMAP mode because it does not support Secure-POP, which is 
required by the Neoteris IVE. If your corporate mail server is a Microsoft Exchange Server and users 
use the Outlook 2000 or 2002 email program when in the office, note that when using the Netscape 
program, deleted emails are moved to the Netscape Trash folder and no longer appear in the Netscape 
Inbox, but they do not disappear from the Outlook 2000 or 2002 Inbox unless users do two things:

1 Configure the Netscape program to move deleted messages to the Trash folder and check the 
option to expunge the Inbox upon exiting (using the Mail Server Properties dialog).

2 Run only one program at a time and exit when finished so that the other program’s Inbox synchro-
nizes with the server and displays the same messages.

To configure the Netscape Messenger 4.7x email program:

1. From the Netscape Messenger Edit menu, choose Preferences. The Preferences dialog appears.
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2. In the Preferences dialog, expand Mail & Newsgroups and then choose Mail Servers.

 Figure 19:  Preferences Dialog

3. In the Mail Servers section, delete any mail servers listed under Incoming Mail Servers and then 
click Add. The Mail Server Properties dialog appears.

4. In the Mail Server Properties dialog, select the General tab to configure the mail server:

Enter the name of the IVE server, specify IMAP as the type of mail server, and enter the name you use 
to log in to your corporate mail server. If you do not enter the same password each time for email, 
make sure to clear the Remember password box. For example, if you entered email settings through 
the IVE Email Setup page, enter the mail server name and user name that displayed after you 
completed the setup. If you did not enter email settings through the IVE Email Setup page and the 
URL to your IVE is https://IVEserver.yourcompany.com, then the address to enter as the incoming 
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and outgoing mail server is IVEserver.yourcompany.com. 

 Figure 20:  Mail Server Properties Dialog - General Tab

5. In the Mail Server Properties dialog, select the IMAP tab to configure connection and deletion 
settings:

Select Use secure connection (SSL), Move it to the trash folder and Clean up (“Expunge”) 
Inbox on exit. When you are finished, click OK to return to the Mail Servers section of the 
Preferences dialog. 

6. Under Outgoing Mail Server:

• Make sure the Outgoing mail (SMTP) server is the server you entered in In the Mail Server 
Properties dialog, select the General tab to configure the mail server:. If not, enter the server 
name now.

• In the Outgoing mail server user name field, enter the name you use to log in to your 
corporate mail server.

• Under Use Secure Socket Layer (SSL) or TSL for outgoing messages, select Always. The 
new account appears in your list of email accounts.

7. When you are finished, click OK. 
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To begin using your new email account, expand the account name so that you see the Inbox and its 
messages. You may need to click the Get Msg button in the Netscape Messenger toolbar. When 
prompted for your password, enter the password required by your system administrator.

Important:If your system administrator has not obtained a signed digital certificate for the IVE server, you
may be prompted with one or more security or IP address warnings each time you open the Inbox. The
IVE server is fully functional and secure, however, and you may choose to proceed.

Netscape Mail 6.2

To retrieve email form a remote location using Netscape Mail on a laptop or home machine, users must 
configure Netscape Mail in IMAP mode because it does not support Secure-POP, which is required by the 
Neoteris IVE. If your corporate mail server is a Microsoft Exchange Server and users use the Outlook 
2000 or 2002 email program when in the office, note that when using the Netscape program, deleted 
emails are moved to the Netscape Trash folder and no longer appear in the Netscape Inbox, but they do 
not disappear from the Outlook 2000 or 2002 Inbox unless users do two things:

1 Configure the Netscape program to move deleted messages to the Trash folder and check the 
option to expunge the Inbox upon exiting (using the Server Settings dialog).

2 Run only one program at a time and exit when finished so that the other program’s Inbox synchro-
nizes with the server and displays the same messages.
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To configure the Netscape Mail 6.2 email program:

1. From the Netscape 6 browser Tasks menu, choose Mail & Newsgroups. The Local Folders page 
appears.

 Figure 21:  Local Folders Page in Netscape 6

2. On the Local Folders page, click Create a new account to launch the Account Wizard.

3. On the New Account Setup page, make sure ISP or email provider is selected and click Next.
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4. On the Identity page, enter the name to be displayed for messages sent from your account and your 
corporate email address. When you are finished, click Next.

 Figure 22:  Account Wizard - Identity Page

5. On the Server Information page, specify IMAP as the type of mail server, enter the name of the IVE 
server¹ for both the incoming and outgoing mail servers², and click Next.

¹If you entered email settings through the IVE Email Setup page, enter the mail server name that 
displayed after you completed the setup. If you did not enter email settings through the IVE Email 
Setup page and the URL to your IVE is https://IVEserver.yourcompany.com, then the address to 
enter as the incoming and outgoing mail server is IVEserver.yourcompany.com.
²If an IMAP server was previously defined for your email program, then you won't be prompted for an 
outgoing server name. In this case, you will need to set the IVE server as your default mail server in 
In the Outgoing Server (SMTP) Settings section, click Always under Use secure connection (SSL), and 
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then click Advanced. The Advanced Outgoing Server (SMTP) Settings dialog appears.. 

 Figure 23:  Account Wizard - Server Information Page

6. On the User Name page, enter the name you use to log in to your corporate mail server. When you 
are finished, click Next. For example, if you entered email settings through the IVE Email Setup 
page, enter the user name that displayed after you completed the setup.

7. On the Account Name page, enter a name for your account and then click Next.

8. On the Congratulations page, click Finish to save your changes and exit the wizard. The new 
account appears on the Local Folders page.

9. From the Local Folders page Edit menu, choose Mail & Newsgroups Account Settings. The Mail 
& Newsgroups Account Settings dialog appears.
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10. In the Mail & Newsgroups Account Settings dialog, choose Server Settings under the account 
you just created.

 Figure 24:  Mail & Newsgroups Account Settings

11. In the Server Settings section:

• Check Use secure connection (SSL). Note that the port number automatically changes to 993.
• For When I delete a message, select Move it to the Trash folder.
• Check Clean up (“Expunge”) Inbox on Exit.

12. In the Mail & Newsgroups Account Settings dialog, select Outgoing Server (SMTP). The 
Outgoing Server (SMTP) Settings section appears.
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13. In the Outgoing Server (SMTP) Settings section, click Always under Use secure connection 
(SSL), and then click Advanced. The Advanced Outgoing Server (SMTP) Settings dialog 
appears.

 Figure 25:  Advanced Outgoing Server (SMTP) Settings Dialog

The IVE server name you entered on the Server Information page (On the Server Information page, 
specify IMAP as the type of mail server, enter the name of the IVE server¹ for both the incoming and 
outgoing mail servers², and click Next.) should appear as the default server. If it does not, select the 
IVE server name and click Set Default.

14. When you are finished, click OK to return to the Mail & Newsgroups Account Settings dialog, and 
then click OK again.

To begin using your new email account, expand the account name so that you see the Inbox and its 
messages. You may need to click the Get Msg button in the Netscape Messenger toolbar. When 
prompted for your password, enter the password required by your system administrator.

Important:If your system administrator has not obtained a signed digital certificate for the IVE server, you
may be prompted with one or more security or IP address warnings each time you open the Inbox. The
IVE server is fully functional and secure, however, and you may choose to proceed.


